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 This research was conducted along the coastline 

situated in the area of Desa Keraya, Kumai, 

Kotawaringin Barat Regency, Central 

Kalimantan. The study utilized Landsat 7 ETM+ 

and Landsat 8 OLI-TIRS satellite image data 

spanning from 2003 to 2023 to analyze the 

changes in Desa Keraya's coastline due to 

abrasion and accretion. The NSM and EPR 

approaches were employed to analyze the 

coastline alterations and calculate erosion rates. 

This study provides an in-depth understanding 

of the dynamics of coastline changes and erosion 

rates in Desa Keraya over the last two decades. 

The coastline of Desa Keraya experienced an 

average abrasion of 7.34 meters (2003-2013) 

and 14.44 meters (2013-2023), along with an 

average accretion of 6.70 meters (2013-2023). 

The abrasion rate increased from 0.70 to 1.52 

meters per year (2003-2013 to 2013-2023), 

while accretion decreased from 1.41 to 0.71 

meters per year (2003-2013 to 2013-2023). 
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1. PENDAHULUAN 

Indonesia dikenal sebagai negara 

maritim karena mempunyai perairan 

laut luas dan garis pantai paling panjang 

kedua di dunia. Indonesia terdiri dari 

17.499 pulau dengan luas 5,9 juta km2 

dan garis pantai ±81.000 km2 (Pusat 

Hidrografi dan Oceanografi, 2004 

dalam Nurmalahayati et al., 2021). 

Pelestarian dan pemanfaatan di wilayah 

pesisir atau pelestarian ekosistem laut 

dapat menimbulkan kerusakan di 

wilayah pesisir, seperti abrasi. Oleh 

karena itu, pantai-pantai di Indonesia 

sering mengalami abrasi, termasuk di 

Pantai Keraya. Desa Keraya merupakan 

salah satu desa di Kumai, Kalimantan 

Tengah memiliki luas wilayah 72 km2 

dan tinggi daerah 2 mdpl. Desa Keraya 

berbatasan langsung dengan Laut Jawa 

sehingga dipengaruhi pasang surut air 

laut dan rentan terhadap perubahan 

lingkungan serta resiko mengalami 

abrasi sangat besar. Garis pantai di Desa 

Keraya pada tahun 2009 hingga 2019 

mengalami pengurangan sejauh kurang 

lebih 30 meter akibat terjadinya abrasi 

(Ruhaidani et al., 2019).  

 Dilansir dari situs web 

https://kumparan.com/infopbun-admin 

dengan judul “Penanganan Abrasi 

Mendapat Bantuan APBN Rp 2,5 

Milyar”, pada tahun 2019 Pemerintah 

Kabupaten Kotawaringin Barat akan 

membangun breakwater sepanjang 950 

meter untuk mengatasi abrasi pantai 

yang terjadi di pantai Desa Keraya 

tersebut. Selain itu, akan dibangun juga 

reveatment pada bibir pantai untuk 

menahan jalan yang tergerus ombak.  

Namun, pembangunan breakwater ini 

belum optimal mengatasi abrasi yang 

terjadi karena adanya cuaca ekstrem 

yang semakin memperparah abrasi dan 

mengancam penduduk sekitar. 

Berdasarkan wawancara dengan wakil 

bupati Kotawaringin Barat pada tahun 

2021 pantai di Desa Keraya mengalami 

abrasi karena masih ada kawasan pantai 

sepanjang 750 meter yang belum 

terlindungi oleh bangunan pemecah 

ombak. Sehingga pada saat terjadinya 

gelombang tinggi langsung menerpa 

rumah warga dan jalanan (Prokom 

Kobar, 2021) 

Survei Geologi Amerika Serikat 

(USGS) telah membuat toolbar yang 

disebut Digital Shoreline Analysis 

System (DSAS) yang memanfaatkan 

GIS sebagai platform dan metodologi 

https://kumparan.com/infopbun-admin/penanganan-abrasi-mendapat-bantuan-apbn-rp-2-5-milyar
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berbasis observasi untuk menghitung 

laju perubahan garis pantai dan secara 

akurat memprediksi perubahan garis 

pantai dalam waktu dekat. Hal ini 

menciptakan transek yang sejajar 

dengan garis pangkal referensi di 

sepanjang pantai pada jarak yang 

ditentukan pengguna. Garis dasar 

transek dan setiap titik perpotongan 

garis pantai diberi jarak yang berbeda, 

sehingga memudahkan untuk mengukur 

perubahan garis pantai dengan statistik 

atau pengukuran jarak yang 

menyediakan semua perhitungan dalam 

sebuah tabel yang terhubung ke file 

transek dengan tabel atribut. Perilaku 

morfodinamik garis pantai dan 

perpindahan yang berhubungan dengan 

geometrinya ditentukan oleh DSAS 

(Moussaid, et al., 2015 dalam 

Parthasarathy & Deka, 2019).  

 

2. METODE PENELITIAN 

2.1.  Waktu dan Tempat 

Penelitian ini dikerjakan di area 

pantai yang terletak di wilayah Desa 

Keraya, Kotawaringin Barat, 

Kalimantan Tengah, pada bulan Maret 

2023. Pemilihan lokasi ini diputuskan 

berdasarkan adanya perubahan 

fenomena garis pantai yang teramati di 

pantai yang terletak di desa tersebut.  

2.2. Alat dan Bahan 

Alat serta bahan yang dipakai 

seperti Envi 5.0, ArcGis 10.4, Data SHP 

Administrasi Desa Keraya, Citra 

Landsat 7 ETM+ Path 120 Row 062 

Tahun 2003, Citra Landsat 8 OLI-TIRS 

120 Row 062 Tahun 2013, Citra 

Landsat 8 OLI-TIRS Path 120 Row 062 

Tahun 2023, Aviso Altimetri, ETOPO1, 

Data Angin. 

2.3. Pengolahan Data 

Pengolahan data dilakukan dengan 

memanfaatkan software Global 

Mapper, ArcGis 10.4 dan Envi 5.3. 

Urutan tahapan pengolahan data di 

penelitian ini yaitu: 

A. Arus 

Data arus yang didapatkan dilakukan 

pengolahan data untuk membuat peta 

kecepatan dan arah arus dengan 

menggunakan software ArcMap. 

Adapun tahapannya yaitu: 

1. Membuka software ArcMap dan 

mengklik Add Data, kemudian 

memasukkan shapefile wilayah 

Desa Keraya. 
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2. Mengklik File > Add Data > Add 

XY Data, pilih data arus yang 

diperoleh. 

3. Mengatur X Field menjadi 

Longitude, Y Field menjadi 

Latitude dan Z Field menjadi Data 

Kecepatan Arus, kemudian klik 

OK. 

4. Kemudian mengekspor data untuk 

mengubah bentuk shapefile 

dengan klik kanan Data > Export 

Data, kemudian memilih lokasi 

penyimpanan dan klik OK. 

5. Melakukan interpolasi dengan 

membuka ArcToolbox > Spatial 

Analyst Tools > Interpolasi > 

IDW. 

6. Memilih input point features 

dengan shapefile point. Ubah Z 

value field menjadi data 

kecepatan arus, menentukan 

lokasi penyimpanan dan klik OK. 

7. Mengatur warna tampilan dengan 

mengklik kanan, Properties > 

Symbology > Classified. 

8. Mengatur bentuk dan arah 

kecepatan arus dengan mengklik 

kanan, Properties > Symbology > 

Quantities > Graduated symbols. 

9. Mengubah bentuk titik pada 

bagian Template menjadi panah. 

Klik Asvanced > Rotation dan 

memilih data arah arus klik OK. 

 

2.4. Batimetri 

Data batimetri yang digunakan 

diperoleh dengan mengunduh pada 

website resmi Nationel Oceanic and 

Atmospheric Adminidtration. Data 

tersebut kemudian diolah dengan 

menggunakan aplikasi Global Mapper. 

Adapun tahapannya yaitu: 

1. Membuka aplikasi Global Mapper, 

mengklik open dan masukkan data 

yang dimiliki 

2. Menggunakan tools Creat Area Feature 

untuk  memilih area yang akan dicrop 

3. Mengklik Feature Into Tools untuk 

memilih area yang sudah dipilih 

4. Kemudian klik File > export > export 

vector format, dan memilih format file 

yang digunakan yaitu shapefile. 

5. Menchecklist data yang akan di export, 

dan mengganti nama. 

 

2.5.Pengolahan Citra Landsat 7 ETM+ 

dan Landsat 8 OLI-TIRS 

 

Pengolahan Citra Landsat 7 

ETM+ dan Landsat 8 OLI-TIRS 
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diantaranya yaitu melakukan Koreksi 

Radiometrik, Koreksi Geometrik, 

Cropping, Deliniasi Wilayah Daratan, 

dan Digitasi garis pantai dan overlay. 

 

 

2.6. Net Shoreline Movement (NSM) 

Besarnya perubahan posisi 

garis pantai tertua dan terbaru diukur 

dengan memanfaatkan Net Shoreline 

Movement (NSM). Menurut metode 

ini, jarak dengan nilai positif (+) 

menunjukkan kemajuan atau 

pertambahan pantai, sedangkan jarak 

dengan nilai negatif (-) menunjukkan 

erosi atau kemunduran pantai 

(Paramitha et al., 2020).  

 

2.7. End Point Rate (EPR) 

 Pendekatan EPR (End Point 

Rate) dimanfaatkan untuk 

mengestimasi laju perubahan garis 

pantai dengan membagi jarak antara 

titik pantai yang paling awal tercatat 

dan titik pantai yang paling baru, 

kemudian dibagi oleh selang waktu di 

antara keduanya. Meskipun metode ini 

tergolong sederhana karena hanya 

memerlukan dua titik pantai sebagai 

data, namun metode ini memiliki 

kelemahan yang perlu diperhatikan. 

Jika terdapat penambahan data titik 

pantai dari tahun-tahun berikutnya, 

metode ini tidak dapat lagi diterapkan 

dalam analisis karena batasan 

karakteristiknya (Sutikno, 2014). 

Rumus EPR yang digunakan yaitu: 

 

3. HASIL DAN PEMBAHASAN 

3.1. Perubahan Garis Pantai 

Hasil analisis menggunakan 

DSAS ditampilkan dalam bentuk 

grafik serta bisa dilihat pada Gambar 

1 dan 2. 

 
Gambar 3.1. Grafik Perubahan Garis Pantai 

Desa Keraya Tahun 2003-2013. 
 

 Pada Gambar 3.1, grafik NSM 

tahun 2003-2013 menunjukkan 

mayoritas garis pantai abrasi (47 

transek), dengan abrasi tertinggi di 
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transek 14 (28,04 meter, laju 2,68 

meter/tahun). Sebaliknya, 34 transek 

menunjukkan akresi laut, tertinggi di 

transek 23 (41,30 meter, laju 3,95 

meter/tahun). EPR mengindikasikan 

abrasi rata-rata 0,70 meter/tahun ke 

daratan (stabil) dan akresi rata-rata 1,41 

meter/tahun ke laut (akresi sedang). 

 
Gambar 3.2. Grafik Perubahan Garis Pantai 

Desa Keraya Tahun 2013-2023. 
 

Grafik Gambar 3.2. 

menunjukkan bahwa antara tahun 2013 

dan 2023, mayoritas garis pantai 

mengalami abrasi. Sebanyak 59 transek 

menunjukkan kemunduran pantai 

akibat abrasi, dengan transek 21 

memiliki abrasi tertinggi (55,4 meter, 

laju 5,83 meter/tahun). Sebanyak 22 

transek menunjukkan pantai maju, 

dengan transek 7 memiliki akresi 

tertinggi (17,55 meter, laju 1,85 

meter/tahun). Penghitungan EPR 

menunjukkan laju abrasi rata-rata 1,52 

meter/tahun (tingkat tinggi) dan laju 

akresi rata-rata 0,71 meter/tahun 

(tingkat stabil). 

Pada periode 2003-2013, garis 

pantai Desa Keraya mengalami abrasi 

seluas 1,76 Ha dengan laju 0,176 

Ha/tahun. Pada tahun 2013-2023, 

seluas 4,07 Ha dengan laju 0,407 

Ha/tahun. Luas area akresi pada tahun 

2003-2013 adalah 2,42 Ha dengan laju 

0,242 Ha/tahun dan pada tahun 2013-

2023 adalah 0,76 Ha dengan laju 0,076 

Ha/tahun. Secara total, luas area yang 

mengalami abrasi dari 2003-2023 

adalah 5,83 Ha dengan laju 0,583 

Ha/tahun, sementara luas area akresi 

adalah 3,18 Ha dengan laju 0,318 

Ha/tahun. Gambaran perubahan ini 

terlihat pada Gambar 3.1. 

 
Gambar 3.1. Luas Perubahan Garis Pantai 

Tahun 2003-2013. 
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Gambar 3.2. Luas Perubahan Garis Pantai 

Tahun 2013-2023. 
 

Faktor angin memainkan 

peranan penting dalam dinamika 

perubahan garis pantai. Proses 

pembentukan gelombang adalah salah 

satu dampak utama dari angin. 

Gelombang yang bergerak dari perairan 

laut ke daratan berinteraksi dengan 

dasar laut pada kedalaman tertentu, 

membawa material sedimen yang 

kemudian mempengaruhi distribusi 

sedimen di sekitar zona pantai. Semakin 

tinggi kecepatan angin, semakin kuat 

pula gelombang yang dihasilkan. 

Gelombang ini kemudian datang 

menghantam pantai dengan sudut 

tertentu, seringkali memicu arus sejajar 

garis pantai. Arus ini memiliki peranan 

krusial dalam mengatur pola 

penyebaran sedimen sepanjang garis 

pantai (Setyawan, dkk., 2021). Arah 

angin lokasi penelitian bisa dilihat di 

Gambar 3.3. dan 3.4. 

 
Gambar 3.3. Arah Angin Tahun 2003. 

 

 
Gambar 3.4. Arah Angin Tahun 2013. 

 

 Angin memiliki pengaruh 

langsung terhadap pembentukan dan 

arah arus di perairan. Pada perairan 

dangkal angin cenderung memiliki 

pengaruh yang lebih besar terhadap 

pembentukan arus permukaan. Perairan 

pesisir di Desa Keraya merupakan 

perairan laut dangkal atau kurang dari 

200m yaitu berkisar antara 0-20 meter. 

Gambaran kedalaman perairan dapat 

terlihat pada Gambar 3.5. 
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Gambar 3.5. Kedalaman Perairan Desa Keraya 

 

Angin yang berhembus kuat 

dapat mendorong permukaan air laut 

dan menciptakan aliran air yang 

mengarah ke arah angin. Pada Gambar 

5 dan 6 dapat terlihat jika angin bertiup 

dari arah timur laut-timur, sehingga 

menghasilkan arus seperti pada Gambar 

8. 

 
(a) 

 
(b) 

 
(c) 

Gambar 3.6. Persebaran Arus Tahun (a) 2003 

(b) 2013 (c) 2023. 

 

 

3.2.Analisis DPSIR Perubahan 

Garis Pantai 

 

Metode DPSIR (Driver, 

Pressure, State, Impact, and Response) 

dimanfaatkan sebagai alat analisis 

untuk mengidentifikasi masalah 

lingkungan dan pemahaman 

masyarakat terhadap isu-isu tersebut 

(OECD, 1993 dalam Aziz, 2023). 

Menurut Hendriarianti, dkk. (2022), 

struktur DPSIR didasarkan pada ide 

bahwa faktor pendorong (driver) yang 

bisa berupa proses alam atau aktivitas 

manusia, menghasilkan tekanan 

(pressure) pada lingkungan yang pada 

akhirnya mempengaruhi kondisi 

lingkungan (state). Perubahan kondisi 

lingkungan ini kemudian menciptakan 

dampak pada masyarakat, yang 

kemudian merespons perubahan dan 

dampak tersebut melalui berbagai 

kebijakan dan program (response). 

DPSIR menjadi alat analisis yang 

berfungsi untuk mengkaji hubungan 

antara berbagai faktor yang 

memengaruhi kondisi lingkungan. 

Dalam penelitian ini, analisis 

DPSIR diterapkan untuk 

mengidentifikasi permasalahan yang 

terkait dengan perubahan garis pantai di 
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Desa Keraya serta memahami 

pandangan masyarakat mengenai 

fenomena tersebut. Pada konteks 

perubahan garis pantai yang dipicu oleh 

faktor alam, pendekatan DPSIR 

dimanfaakan untuk menggambarkan 

interaksi dan kontribusi berbagai faktor 

alam terhadap perubahan garis pantai di 

Desa Keraya. Analisis DPSIR 

diaplikasikan guna merinci proses 

perubahan garis pantai di wilayah 

tersebut. 

 
 

Gambar 3.7. Analisis DPSIR Perubahan Garis 

Pantai. 

 

 

 

 
 

 

 

 

 

 

4. KESIMPULAN DAN 

SARAN 

4.1. Kesimpulan 

Kesimpulan pada penelitian ini 

adalah: 

1. Garis pantai di Desa Keraya pada 

tahun 2003-2013 mengalami 

perubahan rata-rata abrasi 7,34 

meter dengan perubahan paling 

tinggi sebesar 28,04 meter ke arah 

daratan dan rata-rata abrasi 14,72 

meter dengan perubahan paling 

tinggi 41,30 meter ke arah laut. 

Tahun 2013-2023 rata-rata 

perubahan garis pantai sebesar 

14,44 meter dengan perubahan 

paling tinggi sebesar 55,4 meter 

ke arah daratan dan rata-rata 

akresi sebesar 6,70 meter dengan 

perubahan paling tunggi sebesar 

17,55 meter ke arah lautan. 

2. Laju abrasi pada tahun 2003-2013 

sebesar 0,70 meter/tahun dan 

tahun 2013-2023 sebesar 1,52 

meter/tahun. Sedangkan akresi 

pada tahun 2003-2013 sebesar 

1,41 meter/tahun dan 0,71 

meter/tahun pada tahun 2013-

2023. 
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4.2. Saran 

 Sebagai rekomendasi, peneliti 

menyarankan perlunya penelitian 

mendalam mengenai faktor-faktor 

pemicu perubahan garis pantai, seperti 

pengaruh pasang surut dan gelombang. 

Selain itu, penting untuk mengambil 

tindakan lebih lanjut dalam mengatasi 

dampak yang timbul akibat abrasi, 

melalui campur tangan pemerintah dan 

kerja sama dengan instansi di tingkat 

desa. 
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